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Ms	office	word	objective	questions	and	answers



Computer	Basic	Microsoft	Word	questions	with	answer	(Microsoft	Word	mcq)	:	in	which	view	headers	and	footers	are	visible	the	process	of	removing	unwanted	part	of	an	image	is	called	to	apply	center	alignment	to	a	paragraph	we	can	press	the	space	left	between	the	margin	and	the	start	of	a	paragraph	is	called	text-styling	feature	of	ms	word	isMS
Word	objective	type	mcq	(multiple	choice)	Online	Test	:	Microsoft	Word	is	a	word	processing	application	designed	by	Microsoft.	Microsoft	Word,	i.e.	MS	Word,	is	a	part	of	the	popular	MS	Office	Package.	Here	you	will	find	a	good	collection	of	Multiple	Choice	Questions	to	test	your	knowledge	on	Microsoft	Word	with	answer.	Most	of	the	questions	are
applicable	to	all	versions	of	MS	Word	(including	Word	97-2003,	2007,	2010,	XP,	etc.).	Sometimes	these	types	of	questions	are	asked	as	part	of	the	general	knowledge	section	of	basic	computer	awareness	and	computer	operation	section.	MS	Word	MCQ	Question	with	AnswerHere	you	will	find	a	list	of	common	important	questions	on	microsoft	word	in
MCQ	quiz	style	with	answer	for	competitive	exams	and	interviews.	These	frequently	asked	sample	questions	on	MS	Word	are	given	with	correct	choice	of	answer	that	you	can	check	instantly.	Presently	we	have	added	total	4	sets	of	questions	on	microsoft	word	for	you	to	practice.	We	will	keep	adding	more	questions	and	provide	this	question	bank	in
PDF	format,	so	that	you	can	download	them	instantly	in	E-book	style.Following	section	consists	of	some	important	multiple	choice	questions	(mcq)	on	microsoft	word	with	answers.TEST	INSTRUCTION:	CLICK	OPTION	(A,	B,	C,	D)	TO	SEE	ANSWER.	Q.	Answer	Answer	:	Print	Layout	View	[Option	:	C]	Show	Answer	Q.	Answer	Answer	:	Cropping	[Option
:	C]	Show	Answer	Q.	Answer	Answer	:	Ctrl	+	E	[Option	:	D]	Show	Answer	Q.	Answer	Answer	:	Indentation	[Option	:	C]	Show	Answer	Q.	Answer	Answer	:	WordArt	[Option	:	C]	Show	Answer	Question:	11Which	bar	shows	the	current	position	as	far	the	text	goes?	(A)	Title	bar	(B)	Menu	bar	(C)	Scroll	bar	(D)	Status	bar	Question:	12Select	all	the	text	in
MS	Word	document	by	(A)	Ctrl	+S	(B)	Ctrl+	1	(C)	Ctrl+	A	(D)	Ctrl+	V	Question:	13____	is	not	a	part	of	a	MS	Word	document	(A)	Quick	access	toolbar	(B)	Start	Menu	button	(C)	Home	panel	(D)	View	option	Question:	14The	name	of	a	word	document	displays	in	____	(A)	Ribbon	(B)	Title	bar	(C)	Status	bar	(D)	Home	tab	Question:	15Each	line	represents
how	many	letters	in	WordStar?	(A)	20	(B)	35	(C)	65	(D)	75	Related	Questions	Recent	Articles	Trending	Posts	100+	Gk	Questions	on	Climate,	Weather,	Climatology	Questions	More	December-29-2020	|	MeritnotesTNPSC	Group	1,	2,	2a,	4,	Panchayati	Raj	MCQ,	GK,	Quiz	Objective	Questions	More	August-28-2019	|	MeritnotesTop	100+	Indian	Art	and
Culture	MCQ	Quiz	GK	Questions	and	Answers	More	August-28-2019	|	MeritnotesTop	1,000+	IBPS	Puzzle	Questions	with	Answers	Pdf	More	April-22-2021	|	MeritnotesTop	10,000+	Computer	Gk	2020â€“2021	More	November-27-2019	|	MeritnotesInventions	and	Inventors	(Discoveries)	Quiz	in	Physics	for	TNPSC	Pdf	More	August-28-2019	|	Meritnotes
REGISTER	TO	GET	FREE	UPDATES	Home	Terms	&	Conditions	Contact	2021	©	MeritNotes	If	you	want	to	know	all	about	MS	Word	such	as	features,	uses,	go	through	our	MS	Word	Objective	Questions	and	Answers.	You	can	learn	completely	about	Microsoft	Word	by	referring	to	our	MS	Word	Multiple	Choice	Questions.	In	Order	to	clear	your
competitive	exams	with	flying	colors,	you	need	to	have	a	good	hold	of	the	concept	of	MS	Word.	Practice	as	many	times	as	possible	using	these	Microsoft	Word	Quiz	and	test	your	preparation	standards.	MS	Word	Multiple	Choice	Questions	and	Answers	1.	The	ability	to	combine	name	and	addresses	with	a	standard	document	is	called	________	A.
Document	formatting	B.	Database	management	C.	Mail	merge	D.	Form	letters	Answer	Answer:	Option	C	Explanation	:	The	automatic	addition	of	names	and	addresses	from	a	database	to	letters	and	envelopes	in	order	to	facilitate	sending	mail,	especially	advertising,	to	many	addresses.	2.	Which	enables	us	to	send	the	same	letter	to	different	persons?
A.	Macros	B.	Template	C.	Mail	merge	D.	None	of	above	Answer	Answer:	Option	C	Explanation	:	Mail	Merge	is	a	useful	tool	that	allows	us	to	produce	multiple	letters,	labels,	envelopes,	name	tags,	and	more	using	information	stored	in	a	list,	database,	or	spreadsheet.	3.	A	word	processor	would	most	likely	be	used	to	do	A.	Keep	an	account	of	money
spent	B.	Do	a	computer	search	in	media	center	C.	Maintain	an	inventory	D.	Type	a	biography	Answer	Answer:	Option	D	Explanation	:	A	word	processor,	or	word	processing	program,	does	exactly	what	the	name	implies.	It	is	used	to	manipulate	a	text	document,	such	as	a	resume	or	a	report.	We	typically	enter	text	by	typing,	and	the	software	provides
tools	for	copying,	deleting	and	various	types	of	formatting.	So	in	given	options	it	would	most	likely	be	used	to	do	type	a	biography.	4.	What	is	gutter	margin?	A.	Margin	that	is	added	to	the	left	margin	when	printing	B.	Margin	that	is	added	to	right	margin	when	printing	C.	Margin	that	is	added	to	the	binding	side	of	page	when	printing	D.	Margin	that	is
added	to	the	outside	of	the	page	when	printing	Answer	Answer:	Option	C	Explanation	:	The	gutter	margin	is	a	typographical	term	used	to	designate	an	additional	margin	added	to	a	page	layout	to	compensate	for	the	part	of	the	paper	made	unusable	by	the	binding	process.	In	a	facing	pages	layout	(Word	refers	to	this	type	of	layout	as	“mirror
margins”),	the	gutter	margin	is	on	the	very	inside	of	both	pages.	5.	Which	can	be	used	for	quick	access	to	commonly	used	commands	and	tools?	A.	Status	bar	B.	Tool	bar	C.	Menu	bar	D.	Title	bar	Answer	Answer:	Option	B	Explanation	:	In	Word	2003,	Tool	bar	is	used	for	quick	access	to	commonly	used	commands	and	tools.	6.	What	is	the	default	left
margin	in	Word	2003	document?	A.	1	B.	1.25	C.	1.5	D.	2	Answer	Answer:	Option	B	Explanation	:	In	Word	2003	and	earlier,	the	default	top	and	bottom	margins	were	1	inch	(25.4	mm),	but	1.25	inches	(31.7	mm)	were	given	at	the	left	and	the	right.	The	default	margins	for	Microsoft	Word	from	version	2007	onward	have	been	1	inch	(25.4	mm)	all
around.	7.	If	you	need	to	change	the	typeface	of	a	document,	which	menu	will	you	choose?	A.	Edit	B.	View	C.	Format	D.	Tools	Answer	Answer:	Option	C	Explanation	:	Format	menu	is	used	to	change	typeface	of	a	document.	8.	Which	of	the	following	is	not	a	font	style?	A.	Bold	B.	Italics	C.	Regular	D.	Superscript	Answer	Answer:	Option	D	Explanation	:	A
superscript	is	a	character,	symbol	or	number	set	slightly	above	the	normal	line	of	text.	It	is	always	smaller	than	the	usual	font	and	is	typically	found	in	mathematical	or	scientific	formulas.	it	is	effects	to	the	font.	9.	What	is	the	maximum	font	size	you	can	apply	for	any	character?	A.	163	B.	1638	C.	16038	D.	72	E.	None	of	above	Answer	Answer:	Option	B
Explanation	:	The	maximum	font-size	available	in	Microsoft	Word	2010	from	the	dropdown	list	is	72;	however	the	font	size	can	be	set	up	to	1638	by	typing	the	size	manually	for	the	font	10.	To	autofit	the	width	of	column	A.	Double	click	the	left	border	of	column	B.	Double	click	the	right	border	of	column	C.	Double	click	the	column	header	D.	All	of
above	Answer	Answer:	Option	B	Explanation	:	To	make	the	columns	in	a	table	automatically	fit	the	contents,	click	on	our	table.	On	the	Layout	tab,	in	the	Cell	Size	group,	click	AutoFit,	and	then	click	AutoFit	Contents.	or	double	click	the	right	border	of	column.	11.	The	key	F12	opens	a	A.	Save	As	dialog	box	B.	Open	dialog	box	C.	Save	dialog	box	D.
Close	dialog	box	Answer	Answer:	Option	A	Explanation	:	The	key	F12	opens	a	Save	As	dialog	box.	12.	Ctrl	+	I	is	used	to	A.	Italic	B.	Left	Indent	C.	Save	Document	D.	Close	Document	Answer	Answer:	Option	A	Explanation	:	Ctrl	+	I	is	used	to	applies	italic	format	to	selected	text.	13.	Ctrl	+	S	is	used	to	A.	Save	Document	with	different	name	B.	Save
Document	with	same	name	C.	Save	Document	and	Close	Word	Application	D.	Save	Document	and	Print	whole	Pages	Answer	Answer:	Option	B	Explanation	:	Ctrl	+	S	is	used	to	Save	Document	with	same	name.	14.	If	you	will	be	displaying	or	printing	your	document	on	another	computer,	you’ll	want	to	make	sure	and	select	the	________	option	under	the
‘Save’	tab.	A.	Embed	Fonts	B.	Embed	True	Type	Fonts	C.	Save	True	Type	Fonts	D.	Save	Fonts	Answer	Answer:	Option	A	Explanation	:	If	you	will	be	displaying	or	printing	your	document	on	another	computer,	you’ll	want	to	make	sure	and	select	the	Embed	Fonts	option	under	the	‘Save’	tab.	In	Microsoft	Word	2003	and	earlier	versions	–	Choose	Options
from	the	Tools	menu	>	Word	displays	the	Options	dialog	box	>	Click	the	Save	tab	and	put	a	check	next	to	Embed	True	Type	Fonts.	In	Microsoft	Word	2007	and	higher	versions	–	Click	the	Office/File	button	and	then	click	Options	>	At	the	left	of	the	dialog	box	click	Save	>	Make	sure	the	Embed	Fonts	In	the	File	check	box	is	selected.	15.	Ctrl	+	J	is
used	to	A.	Align	Justify	B.	Insert	Hyperlink	C.	Search	D.	Print	Answer	Answer:	Option	A	Explanation	:	Ctrl+J	aligns	the	selected	text	or	line	to	justify	the	screen.	16.	Page	Down	Key	is	used	to	A.	Moves	the	cursor	one	line	down	B.	Moves	the	cursor	one	page	down	C.	Moves	the	cursor	one	screen	down	D.	Moves	the	cursor	one	paragraph	down	Answer
Answer:	Option	C	Explanation	:	Page	Down	Key	is	used	to	move	the	cursor	one	screen	down.	17.	“Ctrl	+	PageUp”	is	used	to	A.	Moves	the	cursor	one	Page	Up	B.	Moves	the	cursor	one	Paragraph	Up	C.	Moves	the	cursor	one	Screen	Up	D.	Moves	the	cursor	one	Line	Up	Answer	Answer:	Option	A	Explanation	:	“Ctrl	+	PageUp”	is	used	to	move	the	cursor
one	Page	Up.	18.	“Ctrl	+	Up	Arrow”	is	used	to	A.	Moves	the	cursor	one	page	up	B.	Moves	the	cursor	one	line	up	C.	Moves	the	cursor	one	screen	up	D.	Moves	the	cursor	one	paragraph	up	Answer	Answer:	Option	D	Explanation	:	“Ctrl	+	Up	Arrow”	is	used	to	move	the	cursor	one	paragraph	up.	19.	“Ctrl	+	Home”	is	used	to	A.	Moves	the	cursor	to	the
beginning	of	Document	B.	Moves	the	cursor	to	the	beginning	of	Line	C.	Moves	the	cursor	to	the	beginning	of	Paragraph	D.	All	of	the	above	Answer	Answer:	Option	A	Explanation	:	“Ctrl	+	Home”	is	used	to	moves	the	cursor	to	the	beginning	of	Document.	20.	“Ctrl	+	End”	is	used	to	A.	Moves	the	cursor	to	the	end	of	Line	B.	Moves	the	cursor	to	the	end
of	Document	C.	Moves	the	cursor	to	the	end	of	Paragraph	D.	None	of	the	Above	Answer	Answer:	Option	B	Explanation	:	“Ctrl	+	End”	is	used	to	move	the	cursor	to	the	end	of	Document.	21.	Which	of	the	following	is	not	essential	component	to	perform	a	mail	merge	operation?	A.	Main	document	B.	Data	source	C.	Merge	fields	D.	Word	fields	Answer
Answer:	Option	D	Explanation	:	There	are	three	components	of	a	Mail	Merge:	The	main	document	controls	the	merge.	It	contains	the	fixed	information	that	will	be	in	every	letter	and	the	merged	codes	where	the	variable	text	will	be.	The	data	source	is	a	document	or	database	that	contains	the	information	that	will	be	different	for	each	letter.
Remember,	the	data	source	is	usually	the	names	and	addresses.	It	can	be	stored	in	a	table	in	Word,	an	Excel	Spreadsheet	or	a	table	in	Access.	The	merged	document	is	the	result	of	a	merge.	These	are	the	individual	letters	that	result	from	the	merge.	The	merge	fields	are	replaced	with	the	actual	data	from	the	Data	Source	file.	22.	When	the	Language
bar	is	________,	it	means	that	you	do	not	see	it	on	the	screen	but	it	will	be	displayed	the	next	time	you	start	your	computer.	A.	Restored	B.	Hidden	C.	Minimized	D.	Closed	Answer	Answer:	Option	B	Explanation	:	When	the	Language	bar	is	hidden,	it	means	that	you	do	not	see	it	on	the	screen	but	it	will	be	displayed	the	next	time	you	start	your	computer.
23.	AutoCorrect	was	originally	designed	to	replace	_________	words	as	you	type.	A.	Short	repetitive	B.	Grammatically	incorrect	C.	Misspelled	D.	None	of	the	above	Answer	Answer:	Option	C	Explanation	:	Misspelled	words	will	automatically	be	corrected	while	typing	with	Autocorrect	feature.	24.	Home	Key	uses	for	A.	Moves	the	cursor	beginning	of	the
document	B.	Moves	the	cursor	beginning	of	the	paragraph	C.	Moves	the	cursor	beginning	of	the	screen	D.	Moves	the	cursor	beginning	of	the	line	Answer	Answer:	Option	D	Explanation	:	The	Home	key	is	primarily	used	to	return	the	typing	cursor	to	the	beginning	of	the	line	on	which	you’re	currently	typing.	This	key	returns	may	also	move	the	cursor
to	the	beginning	of	a	document,	webpage,	or	cell.	25.	“Ctrl	+	Right	Arrow”	is	used	to	A.	Moves	the	cursor	one	word	right	B.	Moves	the	cursor	end	of	the	line	C.	Moves	the	cursor	end	of	the	document	D.	Moves	the	cursor	one	Paragraph	down	Answer	Answer:	Option	A	Explanation	:	“Ctrl	+	Right	Arrow”	is	used	to	move	the	cursor	one	word	right	at	a
time.	26.	End	Key	is	used	to	A.	Moves	the	cursor	end	of	the	line	B.	Moves	the	cursor	end	of	the	document	C.	Moves	the	cursor	end	of	the	paragraph	D.	Moves	the	cursor	end	of	the	screen	Answer	Answer:	Option	A	Explanation	:	End	key.	The	End	key	is	a	key	found	on	a	computer	keyboard	that	moves	the	cursor	to	the	end	of	the	line,	document,	page,
cell,	or	screen	of	where	your	cursor	is	positioned.	27.	“Ctrl	+	PageDown”	is	used	to	A.	Moves	the	cursor	one	Paragraph	Down	B.	Moves	the	cursor	one	Page	Down	C.	Moves	the	cursor	one	Line	Down	D.	Moves	the	cursor	one	Screen	Down	Answer	Answer:	Option	B	Explanation	:	“Ctrl	+	PageDown”	is	used	to	move	the	cursor	one	Page	Down.	28.	“Ctrl
+	Down	Arrow”	is	used	to	A.	Moves	the	cursor	one	paragraph	down	B.	Moves	the	cursor	one	line	down	C.	Moves	the	cursor	one	page	down	D.	Moves	the	cursor	one	screen	down	Answer	Answer:	Option	A	Explanation	:	“Ctrl	+	Down	Arrow”	is	used	to	moves	the	cursor	one	paragraph	down.	29.	Page	Up	Key	uses	for	A.	Moves	the	cursor	one	line	up	B.
Moves	the	cursor	one	screen	up	C.	Moves	the	cursor	one	page	up	D.	Moves	the	cursor	one	paragraph	up	Answer	Answer:	Option	B	Explanation	:	Page	Up	Key	is	used	to	move	the	cursor	one	screen	up.	30.	“Ctrl	+	Left	Arrow”	is	used	to	A.	Moves	the	cursor	beginning	of	the	Line	B.	Moves	the	cursor	one	word	left	C.	Moves	the	cursor	one	paragraph	up
D.	Moves	the	cursor	one	paragraph	down	Answer	Answer:	Option	B	Explanation	:	“Ctrl	+	Left	Arrow”	is	used	to	move	the	cursor	one	word	left	at	at	time.	31.	Which	of	the	following	is	not	the	Section	Break	Option?	A.	Next	Page	B.	Previous	Page	C.	Odd	Page	D.	Even	Page	Answer	Answer:	Option	B	Explanation	:	Previous	Page	is	not	the	Section	Break
Option.	32.	Which	of	the	following	is	not	valid	version	of	MS	Office?	A.	Office	2007	B.	Office	Vista	C.	Office	2016	D.	Office	365	Answer	Answer:	Option	B	Explanation	:	Office	Vista	is	not	valid	version	of	MS	Office.	33.	By	default,	on	which	page	the	header	or	the	footer	is	printed?	A.	On	first	page	B.	On	alternate	page	C.	On	every	page	D.	None	of	the
above	Answer	Answer:	Option	C	Explanation	:	A	header	is	the	top	margin	of	each	page,	and	a	footer	is	the	bottom	margin	of	each	page.	Headers	and	footers	are	useful	for	including	material	that	we	want	to	appear	on	every	page	of	a	document	such	as	your	name,	the	title	of	the	document,	or	page	numbers.	34.	Where	can	you	find	the	horizontal	split
bar	on	MS	Word	screen?	A.	On	the	left	of	horizontal	scroll	bar	B.	On	the	right	of	horizontal	scroll	bar	C.	On	the	top	of	vertical	scroll	bar	D.	On	the	bottom	of	vertical	scroll	bar	Answer	Answer:	Option	C	Explanation	:	On	the	top	of	vertical	scroll	bar	we	can	find	the	horizontal	split	bar	on	MS	Word	screen.	35.	Ctrl	+	G	is	used	to	A.	Open	Paragraph	Dialog
box	activating	Goto	Tab	B.	Open	Page	Setup	Dialog	box	activating	Goto	Tab	C.	Open	Find	and	Replace	Dialog	box	with	activating	Goto	Tab	D.	Open	Goto	Dialog	box	Answer	Answer:	Option	C	Explanation	:	Ctrl	+	G	is	used	to	open	Find	and	Replace	Dialog	box	with	activating	Goto	Tab.	36.	Which	of	the	following	are	word	processing	software?	A.
WordPerfect	B.	Wordpad	C.	MS	Word	D.	All	of	above	Answer	Answer:	Option	D	Explanation	:	WordPerfect,	Wordpad	and	MS	Word	are	word	processing	software.	These	are	used	to	manipulate	a	text	document,	such	as	a	resume	or	a	report.	We	typically	enter	text	by	typing,	and	the	software	provides	tools	for	copying,	deleting	and	various	types	of
formatting.	37.	Which	file	starts	MS	Word?	A.	Winword.exe	B.	Word.exe	C.	Msword.exe	D.	Word356.exe	Answer	Answer:	Option	A	Explanation	:	Winword.exe	is	the	executable	file	name	for	Microsoft	Word	which	is	used	when	Word	is	launched.	The	word	WinWord	stands	for	Windows	Word	(Microsoft	Word).	38.	Ctrl	+	N	is	used	to	A.	Save	Document
B.	Open	Document	C.	New	Document	D.	Close	Document	Answer	Answer:	Option	C	Explanation	:	Ctrl	+	N	is	used	to	open	new	document	in	MS	Word.	39.	To	exit	from	the	Resume	Wizard	and	return	to	the	document	window	without	creating	a	resume,	click	the	________	button	in	any	panel	in	the	Resume	Wizard	dialog	box.	A.	Cancel	B.	Back	C.	Next	D.
Finish	Answer	Answer:	Option	D	Explanation	:	To	exit	from	the	Resume	Wizard	and	return	to	the	document	window	without	creating	a	resume,	click	the	finish	button	in	any	panel	in	the	Resume	Wizard	dialog	box	in	Word	2003.	40.	What	are	inserted	as	cross-reference	in	Word?	A.	Placeholders	B.	Bookmarks	C.	Objects	D.	Word	fields	Answer	Answer:
Option	D	Explanation	:	Cross-references	are	inserted	into	our	document	as	fields.	A	field	is	a	set	of	information	that	instructs	Word	to	insert	text,	graphics,	page	numbers,	and	other	material	into	a	document	automatically.	41.	Short	cut	Ctrl	+	F	is	used	to	A.	Open	Find	and	Replace	Dialog	box	with	activating	Find	Tab	B.	Open	Page	Setup	Dialog	box
with	activating	Layout	Tab	C.	Open	Font	Dialog	Box	with	activating	Font	tab	D.	Open	File	Save	as	Dialog	box	Answer	Answer:	Option	A	Explanation	:	Short	cut	Ctrl	+	F	is	used	to	open	Find	and	Replace	Dialog	box	with	activating	Find	Tab.	42.	Short	cut	Ctrl	+	H	is	used	to	A.	Open	Find	and	Replace	Dialog	box	with	activating	Replace	Tab	B.	Open
Format	Dialog	box	activating	Insert	Hyper	Link	tab	C.	Open	Insert	Dialog	box	activating	Insert	Hyper	Link	Tab	D.	Open	Insert	Hyper	Link	Dialog	box	Answer	Answer:	Option	A	Explanation	:	Short	cut	Ctrl	+	H	is	used	to	open	Find	and	Replace	Dialog	box	with	activating	Replace	Tab.	43.	Short	cut	Ctrl	+	P	used	to	A.	Open	Paragraph	Dialog	Box	B.	Open
Page	Format	Dialog	Box	C.	Open	Save	Dialog	Box	D.	Open	Print	Dialog	box	Answer	Answer:	Option	D	Explanation	:	Short	cut	Ctrl	+	P	used	to	open	Print	Dialog	box	44.	Short	cut	Ctrl	+	T	is	used	to	A.	Hanging	Indent	B.	Left	Indent	C.	Open	Tabs	Dialog	box	D.	Terminate	all	opened	Dialog	box	Answer	Answer:	Option	A	Explanation	:	If	you	like	to	use	the
keyboard	to	do	your	formatting,	you	may	be	interested	in	knowing	how	to	format	a	paragraph	to	use	a	hanging	indent	just	by	using	a	keyboard	shortcut.	You	do	this	in	Word	by	pressing	Ctrl+T.	45.	When	sharing	data	in	Office,	the	________	document	is	the	document	in	which	the	data	was	first	entered.	A.	Source	B.	Destination	C.	Original	D.	Primary
Answer	Answer:	Option	A	Explanation	:	A	source	document	is	a	document	in	which	data	collected	for	a	clinical	trial	is	first	recorded.	46.	With	which	view	can	you	see	how	text	and	graphics	will	appear	on	the	printed	page?	A.	Normal	B.	Print	Layout	C.	Outline	D.	Web	Layout	Answer	Answer:	Option	B	Explanation	:	In	Print	Layout	view	we	can	see	how
text	and	graphics	will	appear	on	the	printed	page.	47.	Portrait	and	Landscape	are	A.	Page	Orientation	B.	Paper	Size	C.	Page	Layout	D.	All	of	above	Answer	Answer:	Option	A	Explanation	:	48.	To	verify	that	the	note	text	is	positioned	correctly	on	the	page,	switch	to	_____	view	or	display	the	document	in	print	preview.	A.	Normal	B.	Print	layout	C.	Page
layout	D.	Page	edit	Answer	Answer:	Option	B	Explanation	:	Print	layout	provides	us	with	a	view	of	the	document	where	we	can	see	page	breaks	and	other	features,	as	well	as	the	basic	character	and	paragraph	formatting.	This	is	helpful	when	we	want	to	see	where	text	ends	on	a	page	or	where	paragraphs	break	over	two	pages.	49.	Which	of	the
following	is	true	regarding	page	Orientation	of	a	Document?	A.	Page	Orientation	can	be	changed	at	any	time	B.	Page	Orientation	of	document	determines	by	printer	C.	Page	Orientation	must	be	set	before	start	typing	D.	Page	Orientation	of	a	document	cannot	be	changed.	Answer	Answer:	Option	A	Explanation	:	Word	allows	us	to	create	documents
with	pages	that	are	in	landscape	or	portrait	view.	We	can	change	the	orientation	any	time	you	want	but	it	applies	to	every	single	page	in	a	document.	There	is	no	option	to	change	the	page	orientation	for	a	single	page	in	MS	Word.	50.	Which	feature	helps	you	to	inserts	the	contents	of	the	Clipboard	as	text	without	any	formatting	A.	Paste	Special	B.
Format	Painter	C.	Page	Setup	D.	Styles	Answer	Answer:	Option	A	Explanation	:	Paste	Special	feature	helps	US	to	inserts	the	contents	of	the	Clipboard	as	text	without	any	formatting.	To	invoke	Paste	Special	–	Home	>	Paste	>	Paste	Special	or	CTRL+ALT+V.	51.	Switching	between	portrait	and	landscape	modes	involves	the:	A.	Header	and	footer
toolbar	B.	Print	layout	view	C.	Page	setup	dialog	box	D.	None	of	the	above	Answer	Answer:	Option	C	Explanation	:	52.	Where	can	you	change	the	vertical	alignment?	A.	Formatting	toolbar	B.	Paragraph	dialog	box	C.	Page	Setup	dialog	box	D.	Standard	toolbar	Answer	Answer:	Option	C	Explanation	:	53.	A	________	is	a	collection	of	predefined	design
elements	and	color	schemes.	A.	Feature	B.	Hyperlink	C.	Palette	D.	Theme	Answer	Answer:	Option	D	Explanation	:	Themes	provide	a	complete	design	for	our	document,	including	background	designs,	font	styles,	colors,	and	layouts.	54.	Change	the	________	to	create	a	document	in	wide	format	A.	Page	Orientation	B.	Page	margins	C.	Paper	Style	D.
Paper	Source	Answer	Answer:	Option	A	Explanation	:	Page	orientation	is	the	direction	in	which	a	document	is	displayed	or	printed.	The	two	basic	types	of	page	orientation	are	portrait	(vertical)	and	landscape	(horizontal).	55.	________	formatting	is	the	process	of	changing	the	way	letters,	numbers,	punctuation	marks,	and	symbols	appear	on	the	screen
and	in	print.	A.	Document	B.	Character	C.	Paragraph	D.	Object	Answer	Answer:	Option	B	Explanation	:	Character	Formatting	in	word	allows	us	to	format	text	dozens	of	ways	with	different	text	effects,	colors,	underline	styles,	and	more.	56.	You	can	detect	spelling	and	grammar	errors	by	A.	Press	Shift	+	F7	B.	Press	Ctrl	+	F7	C.	Press	Alt+	F7	D.	Press
F7	Answer	Answer:	Option	D	Explanation	:	F7	commonly	used	to	spell	check	and	grammar	check	a	document	in	Microsoft	programs	such	as	Microsoft	Word,	Outlook,	etc.	57.	How	can	you	break	the	current	column?	A.	Press	Ctrl	+	Shift	+	Enter	B.	Press	Alt	+	Enter	C.	Press	Ctrl	+	Enter	D.	Press	Alt	+	Shift	+	Enter	Answer	Answer:	Option	A
Explanation	:	Ctrl	+	Shift	+	Enter	key	is	used	to	break	the	current	column.	58.	How	can	you	disable	extended	selection	mode?	A.	Press	F8	again	to	disable	B.	Press	Del	to	disable	C.	Press	Esc	to	disable	D.	Press	Enter	to	disable	Answer	Answer:	Option	C	Explanation	:	Extend	Selection	Mode	ends	when	you	cut,	copy	or	format	the	selection	or	press	Esc.
59.	To	instruct	Word	to	stop	bulleting	paragraphs,	do	any	of	the	following	except	________.	A.	Press	the	enter	key	twice	B.	Click	the	Undo	button	on	the	Standard	toolbar	C.	Press	the	backspace	key	to	remove	the	bullet	D.	Click	the	Bullets	button	on	the	Formatting	toolbar	Answer	Answer:	Option	B	Explanation	:	To	instruct	Word	to	stop	bulleting
paragraphs,	do	any	of	the	above	options	except	click	the	Undo	button	on	the	Standard	toolbar.	60.	Which	of	these	toolbars	allows	changing	of	Fonts	and	their	sizes?	A.	Standard	B.	Formatting	C.	Print	Preview	D.	None	of	these	Answer	Answer:	Option	B	Explanation	:	In	Word	2003	and	earlier	versions	Formatting	toolbars	allows	changing	of	Fonts	and
their	sizes.	In	Word	2007	and	higher	versions	–	Home	>	Font	allows	changing	of	Fonts	and	their	sizes.	61.	The	Word	Count	command	on	the	Tools	menu	displays	the	number	of	words	as	well	as	the	number	of	_______	in	the	current	document.	A.	Lines	B.	Characters	C.	Paragraphs	D.	All	of	the	above	Answer	Answer:	Option	D	Explanation	:	Click	on
Word	Count.	Select	Word	Count	from	the	Tools	menu	dropdown.	A	box	displaying	the	number	of	words,	characters,	lines,	pages	and	paragraphs	will	appear	on	the	screen.	The	word	count	for	a	selected	portion	of	text	will	usually	be	displayed	in	the	bottom	bar	of	your	document.	62.	Which	operation	you	will	perform	if	you	need	to	move	a	block	of	text?
A.	Copy	and	Paste	B.	Cut	and	Paste	C.	Paste	and	Delete	D.	Paste	and	Cut	Answer	Answer:	Option	B	Explanation	:	1.	Select	the	text	that	you	want	to	move,	and	then	press	CTRL+	X	(cut)	to	move	the	text.	2.	Click	where	you	want	to	paste	the	text,	and	then	press	CTRL+	V	(paste).	63.	Ctrl	+	V	is	used	to	A.	Paste	Texts	in	the	beginning	of	Document	B.
Paste	Images	in	the	beginning	of	Document	C.	Paste	Tables	at	the	middle	of	Document	D.	None	of	the	above	Answer	Answer:	Option	D	Explanation	:	Ctrl	+	V	is	used	to	paste	a	copy	data	in	windows	operating	system.	64.	The	________,	or	typeface,	defines	the	appearance	and	shape	of	letters,	numbers,	and	special	characters.	A.	Font	B.	Font	size	C.
Point	D.	Paragraph	formatting	Answer	Answer:	Option	A	Explanation	:	The	Font,	or	typeface,	defines	the	appearance	and	shape	of	letters,	numbers,	and	special	characters.	Fonts	and	typefaces	were	two	different	things	—	the	typeface	was	the	specific	design	of	the	letters,	while	the	font	referred	to	the	particular	size	or	style	of	that	typeface.	65.
Columns	dialog	box	can	be	opened	from	A.	Format	menu	Columns	submenu	B.	Double	click	on	column	space	in	ruler	C.	Press	Alt	+	O	+	C	D.	All	of	above	Answer	Answer:	Option	D	Explanation	:	Columns	dialog	box	can	be	opened	from	any	of	the	above	option	in	Word	2003	and	earlier	versions.	In	Word	2007	and	higher	versions	–	Page	Layout	or
Layout	tab,	click	Columns.	At	the	bottom	of	the	list,	choose	More	Columns.	66.	To	view	headers	and	footers,	you	must	switch	to	A.	Normal	view	B.	Print	layout	view	C.	Print	preview	mode	D.	Both	B	and	C	Answer	Answer:	Option	D	Explanation	:	Headers	and	footers	appear	only	in	print	layout	view,	print	preview,	and	in	printed	documents.	67.	Ctrl	+	C
is	used	to	A.	Copy	the	selected	text	B.	Cut	the	selected	text	C.	Print	the	selected	text	D.	Paste	the	selected	text	Answer	Answer:	Option	A	Explanation	:	Ctrl	+	C	is	used	to	copy	the	text	or	image	we	have	selected	and	stores	is	on	your	virtual	clipboard,	until	it	is	overwritten	by	the	next	“cut”	or	“copy”	command.	68.	Ctrl	+	Q	is	used	to	A.	Remove
Paragraph	formatting	(Line	Space	and	Paragraph	Space)	B.	Close	Word	Application	without	saving	Document	C.	Print	Whole	Document	without	confirmation	D.	Does	nothing	Answer	Answer:	Option	A	Explanation	:	In	Microsoft	Word,	Ctrl+Q	is	used	to	remove	the	paragraph’s	formatting.	69.	Background	color	or	effects	applied	on	a	document	is	not
visible	in	A.	Web	layout	view	B.	Print	Layout	view	C.	Reading	View	D.	Print	Preview	Answer	Answer:	Option	D	Explanation	:	Background	color	or	effects	applied	on	a	document	is	not	visible	in	Print	Preview	area.	70.	Short	cut	Ctrl	+	R	is	used	to	A.	Re-Open	the	last	closed	document	B.	Re-Print	the	last	printed	page	C.	Re-Apply	the	last	paragraph
formatting	D.	Right	align	the	selected	Paragraph	Answer	Answer:	Option	D	Explanation	:	Ctrl	+	R	is	used	to	right	align	the	selected	Paragraph.	71.	When	Word	flags	a	possible	spelling	or	grammar	error,	it	also	changes	the	mark	on	the	Spelling	and	Grammar	Status	icon	to	a	________.	A.	Green	X	B.	Green	check	mark	C.	Red	X	D.	Red	check	mark
Answer	Answer:	Option	C	Explanation	:	If	we	typed	a	word	not	in	the	dictionary	(misspelled	or	proper	name),	a	wavy	red	line	appears.	Word	flags	a	possible	error	and	changes	the	Status	icon	to	a	red	X.	72.	Which	of	the	following	is	not	a	font	style?	A.	Bold	B.	Italics	C.	Regular	D.	Superscript	Answer	Answer:	Option	D	Explanation	:	A	superscript	is	a
character,	symbol	or	number	set	slightly	above	the	normal	line	of	text.	It	is	always	smaller	than	the	usual	font	and	is	typically	found	in	mathematical	or	scientific	formulas.	it	is	effects	to	the	font.	73.	The	other	Col#	are	inactive	when	you’ve	select	3	columns.	How	will	you	activate	those	boxes?	A.	Double	click	on	spacing	box	B.	Double	click	on	inactive
Col#	C.	Remove	mark	from	Line	between	checkbox	D.	Remove	mark	from	Equal	Column	Width	check	box	Answer	Answer:	Option	D	Explanation	:	Remove	mark	from	Equal	Column	Width	check	box	to	activate	inactive	other	column.	74.	From	where	you	can	access	Save	command?	A.	Home	tab	B.	Insert	tab	C.	Review	tab	D.	None	of	above	Answer
Answer:	Option	D	Explanation	:	None	of	above.	From	Office	Button	we	can	access	Save	command	in	Word	2007.	From	2010	and	higher	versions	from	File	we	can	access	Save	command.	75.	How	can	you	remove	tab	stop	markers	from	ruler?	A.	Double	click	the	tab	marker	and	choose	Clear	All	B.	Drag	the	tab	stop	marker	out	of	the	ruler	C.	Right	click
the	tab	stop	marker	and	choose	remove	D.	All	of	above	Answer	Answer:	Option	B	Explanation	:	The	easiest	way	to	change	and	remove	tab	stops	is	to	work	with	them	directly	on	the	Ruler.	We	can	drag	a	tab	stop	to	the	right	or	left	to	shift	its	position,	or	we	can	drag	it	off	the	Ruler	entirely	(up	or	down)	to	remove	it.	To	change	a	tab	stop’s	type,	double-
click	the	tab	stop	on	the	Ruler	to	open	the	Tabs	dialog	box	and	make	our	changes	there.	76.	Ctrl	+	M	is	used	to	A.	New	Document	B.	Close	Document	C.	Right	Indent	D.	Left	Indent	Answer	Answer:	Option	D	Explanation	:	CTRL	+	M	is	used	to	Indent	a	paragraph	from	the	left.	77.	Which	of	the	following	is	not	available	on	the	Ruler	of	MS	Word	screen?
A.	Tab	stop	box	B.	Left	Indent	C.	Right	Indent	D.	Center	Indent	Answer	Answer:	Option	D	Explanation	:	Center	Indent	is	not	available	on	the	Ruler	of	MS	Word	screen.	78.	In	Word,	the	default	alignment	for	paragraphs	is	________.	A.	Left-aligned	or	flush	margins	at	the	left	edge	and	uneven	edges	at	the	right	edge	B.	Centered	or	equidistant	from	both
the	left	edge	and	the	right	edge	C.	Right-aligned	or	flush	margins	at	the	right	edge	and	uneven	edges	at	the	left	edge	D.	Justified	or	flush	margins	at	both	the	left	and	right	edges	Answer	Answer:	Option	A	Explanation	:	In	Word,	the	default	alignment	for	paragraphs	is	left-aligned,	or	flush	margins	at	the	left	edge	and	uneven	edges	at	the	right	edge.
79.	In	MS	Word,	Ctrl+S	is	used	to	________	A.	Scenarios	B.	Size	C.	Save	D.	Spelling	Check	Answer	Answer:	Option	C	Explanation	:	In	MS	Word,	Ctrl+S	is	used	to	Save	the	document.	80.	Ctrl	+	W	is	used	to	A.	Save	and	Print	the	Document	B.	Save	and	Close	Word	Application	C.	Save	and	Close	document	D.	Without	Save	Close	Document	Answer
Answer:	Option	C	Explanation	:	Ctrl	+	W	is	used	to	Save	and	Close	document.	81.	What	is	a	portion	of	a	document	in	which	you	set	certain	page	formatting	options?	A.	Page	B.	Document	C.	Section	D.	Page	Setup	Answer	Answer:	Option	C	Explanation	:	82.	If	you	need	to	double	underline	a	word,	how	will	you	do	that?	A.	Go	to	Format	menu	and	then
Font	option.	Open	Underline	Style	and	choose	Double	Underline	B.	From	Format	menu	choose	Font	option	and	then	from	Font	tab	open	Underline	Style	and	select	Double	Underline	C.	Select	the	text	then	choose	Format	>	Font	and	on	Font	tab	open	Underline	Style	and	choose	Double	Underline	D.	Click	double	underline	tool	on	formatting	toolbar
Answer	Answer:	Option	C	Explanation	:	In	Word	2003	and	earlier	versions	–	Select	the	text	then	choose	Format	>	Font	and	on	Font	tab,	open	Underline	Style	and	choose	Double	Underline.	In	Word	2007	and	higher	versions	–	Home	>	Font	>	Select	double	underline	in	the	Underline	style	drop-down	list.	83.	How	can	you	apply	exactly	the	same
formatting	you	did	to	another	text?	A.	Copy	the	text	and	paste	in	new	location.	Then	type	the	new	text	again	B.	Copy	the	text	and	click	on	Paste	Special	tool	on	new	place	C.	Select	the	text	then	click	on	Format	Painter	and	select	the	new	text	D.	All	of	above	Answer	Answer:	Option	C	Explanation	:	Format	Painter	is	used	when	you	want	to	copy
formatting	from	one	item	to	another.	For	example	if	you	have	written	text	in	Word,	and	have	it	formatted	using	a	specific	font	type,	color,	and	font	size	you	could	copy	that	formatting	to	another	section	of	text	by	using	the	Format	Painter	tool.	84.	Which	of	the	following	is	not	one	of	the	three	‘Mail	Merge	Helper’	steps?	A.	Merge	the	two	files	B.	Create
the	main	document	C.	Set	the	mailing	list	parameters	D.	Create	the	data	source	Answer	Answer:	Option	C	Explanation	:	There	are	three	Mail	Merge	Helper	steps:	The	main	document	controls	the	merge.	It	contains	the	fixed	information	that	will	be	in	every	letter	and	the	merged	codes	where	the	variable	text	will	be.	The	data	source	is	a	document	or
database	that	contains	the	information	that	will	be	different	for	each	letter.	Remember,	the	data	source	is	usually	the	names	and	addresses.	It	can	be	stored	in	a	table	in	Word,	an	Excel	Spreadsheet	or	a	table	in	Access.	The	merged	document	is	the	result	of	a	merge.	These	are	the	individual	letters	that	result	from	the	merge.	The	merge	fields	are
replaced	with	the	actual	data	from	the	Data	Source	file.	85.	To	select	a	block	of	text,	click	at	the	beginning	of	the	selection,	scroll	to	the	end	of	the	selection,	position	the	mouse	pointer	at	the	end	of	the	selection,	hold	down	the	________	key,	and	then	click	or	drag	through	the	text.	A.	Ctrl	B.	Alt	C.	Shift	D.	Tab	Answer	Answer:	Option	C	Explanation	:	To
select	a	block	of	text,	click	at	the	beginning	of	the	selection,	scroll	to	the	end	of	the	selection,	position	the	mouse	pointer	at	the	end	of	the	selection,	hold	down	the	Shift	key,	and	then	click	or	drag	through	the	text.	86.	What	is	the	shortcut-key	for	manual	line	break?	A.	CTRL	+	Enter	B.	Alt	+	Enter	C.	Shift	+	Enter	D.	Space	+	Enter	Answer	Answer:
Option	C	Explanation	:	Shift	+	Enter	is	the	shortcut-key	for	manual	line	break.	87.	Which	key	should	be	pressed	to	start	a	new	paragraph	in	MS-Word?	A.	Down	Cursor	Key	B.	Enter	Key	C.	Shift	+	Enter	D.	Ctrl	+	Enter	Answer	Answer:	Option	B	Explanation	:	In	Microsoft	Word	the	default	action	when	pressing	the	Enter	key	is	to	create	a	new
paragraph,	and	not	move	to	the	next	line.	88.	What	is	the	shortcut	key	to	display	field	codes?	A.	Alt	+	F9	B.	Ctrl	+	F9	C.	Shift	+	F9	D.	Space	+	F9	Answer	Answer:	Option	A	Explanation	:	Alt	+	F9	is	the	shortcut	key	to	display	field	codes.	89.	To	use	your	keyboard	instead	of	the	mouse	to	select	tools	on	the	ribbon,	you	display	the	KeyTips	by	pressing
the	________	key.	A.	Alt	B.	Ctrl	C.	Shift	+	Enter	D.	Alt	+	Enter	Answer	Answer:	Option	A	Explanation	:	By	pressing	the	ALT	key	on	your	keyboard,	We	should	see	that	it	has	brought	up	a	highlighted	letter	beside	each	of	the	menu	choices.	Now	press	the	corresponding	letter	to	the	menu	we	want,	and	it	will	open	further,	again	showing	a	highlighted
letter	for	each	submenu	item.	Press	that	letter	on	our	keyboard	and	it	will	take	us	to	that	item.	If	we	want	to	go	back	one	menu	level	just	press	the	escape	key.	90.	Press	________	to	create	a	line	break,	which	advances	the	insertion	point	to	the	beginning	of	the	next	physical	line	–	ignoring	any	paragraph	formatting	instructions.	A.	Shift	+	enter	B.	Ctrl	+
enter	C.	Shift	+	tab	D.	Ctrl	+	tab	Answer	Answer:	Option	A	Explanation	:	Shift+Enter	results	in	a	soft	return,	sometimes	called	a	line	break	or	a	newline	character,	being	entered	in	the	document.	Press	Shift	+	enter	to	create	a	line	break,	which	advances	the	insertion	point	to	the	beginning	of	the	next	physical	line	–	ignoring	any	paragraph	formatting
instructions.	91.	A	word	field	may	consist	of	an	optional	field	instruction	called	a(n)	________	A.	Sub	document	B.	Symbol	C.	Signal	D.	Switch	Answer	Answer:	Option	D	Explanation	:	A	word	field	may	consist	of	an	optional	field	instruction	called	a	Switch.	92.	Essential	business	letter	elements	include	the	________.	A.	Date	line	and	inside	address	B.
Message	C.	Signature	block	D.	all	of	the	above	Answer	Answer:	Option	D	Explanation	:	Essential	business	letter	elements	include	the	all	of	the	above	options.	93.	Which	of	the	following	helps	to	reduce	spelling	error	in	the	document?	A.	Auto	Format	B.	Auto	Correct	C.	Smart	Tags	D.	Auto	Text	Answer	Answer:	Option	B	Explanation	:	The	AutoCorrect



function	will	quickly	fix	the	misspelling	words	and	punctuation	mistakes.	We	do	not	have	to	use	it	intentionally,	it	runs	automatically.	94.	It	is	possible	to	________	a	data	source	before	performing	a	merge.	A.	Create	B.	Modify	C.	Sort	D.	All	of	the	above	Answer	Answer:	Option	D	Explanation	:	It	is	possible	to	create,	modify	and	sort	a	data	source	before
performing	a	merge.	95.	Word	has	Web	authoring	tools	allow	you	to	incorporate	________	on	Web	pages.	A.	Bullets	B.	Hyperlinks	C.	Sounds	D.	All	of	the	above	Answer	Answer:	Option	D	Explanation	:	Word	has	Web	authoring	tools	allow	you	to	incorporate	Bullets,	Hyperlinks,	Sound	on	Web	pages.	96.	When	typing	in	Preeti	font	all	the	Ukars	turn	to
something	else?	What’s	the	cause?	A.	Autotext	B.	Autocorrect	C.	Speller	D.	Preeti	font	does	not	work	with	Word	Answer	Answer:	Option	B	Explanation	:	The	AutoCorrect	function	will	quickly	fix	the	misspelling	words	and	punctuation	mistakes.	We	do	not	have	to	use	it	intentionally,	it	runs	automatically.	97.	Which	of	the	following	commands	should	you
always	use	before	submitting	a	document	to	others?	A.	Find	command	B.	Replace	command	C.	Spelling	and	Grammar	D.	Thesaurus	Answer	Answer:	Option	C	Explanation	:	The	spelling	and	grammar	checker	in	Word	flags	potential	errors	so	that	we	can	quickly	review	and	correct	mistakes,	if	necessary.	In	addition,	the	tool	checks	words	and	phrases
for	clarity	and	offers	suggestions	or	explanations.	So	we	should	always	use	this	tool	before	submitting	a	document	to	others.	98.	What	is	placed	to	the	left	of	horizontal	scroll	bar	A.	Tab	stop	buttons	B.	View	buttons	C.	Split	buttons	D.	Indicators	Answer	Answer:	Option	B	Explanation	:	View	buttons	is	placed	to	the	left	of	horizontal	scroll	bar.	99.	Insert
Date,	Format	Page	Number,	and	Insert	AutoText	are	buttons	on	the	________	toolbar.	A.	Formatting	B.	Header	and	Footer	C.	Standard	D.	Edit	Answer	Answer:	Option	B	Explanation	:	Headers	and	footers	are	useful	for	including	material	that	we	want	to	appear	on	every	page	of	a	document	such	as	your	name,	the	title	of	the	document,	or	page
numbers.	100.	Which	of	the	following	do	you	use	to	change	margins?	A.	Formatting	toolbar	B.	Page	setup	dialog	box	C.	Standard	toolbar	D.	Paragraph	dialog	box	Answer	Answer:	Option	B	Explanation	:	Page	setup	dialog	box	is	used	to	change	margins	in	word	document.	101.	In	order	to	email	a	Word	document	from	within	MS	Word	A.	Office	button	>
Send	to	>	Mail	Recipient	B.	Save	the	file	as	an	email	attachment	C.	Start	Outlook	and	attach	the	file	while	open	in	Word	D.	This	is	an	impossible	operation	Answer	Answer:	Option	A	Explanation	:	Office	button	>	Send	to	>	Mail	Recipient	in	word	2007	102.	A	screen	element	of	MS	Word	that	is	usually	located	below	the	title	bar	that	provides
categorized	options	is	A.	Menu	Bar	B.	Tool	Bar	C.	Status	Bar	D.	All	of	the	above	Answer	Answer:	Option	A	Explanation	:	A	screen	element	of	MS	Word	2003	and	earlier	version	that	is	usually	located	below	the	title	bar	that	provides	categorized	options	is	Menu	Bar.	103.	In	Word	2007	the	Zoom	is	placed	on	A.	View	tab	B.	Home	tab	C.	Status	bar	D.	A	;
C	both	Answer	Answer:	Option	D	Explanation	:	In	Word	2007	and	higher	versions	the	Zoom	is	placed	on	View	tab	and	Status	bar	both.	104.	The	________	is	a	short	horizontal	line	indicating	the	conclusion	of	a	document.	A.	Insertion	point	B.	End	mark	C.	Status	indicator	D.	Scroll	box	Answer	Answer:	Option	B	Explanation	:	An	end	mark	is	often	a	small
circle	or	square	or	horizontal	line	or	other	graphic	image	that	indicates	the	end	of	an	article.	An	easy	method	of	creating	an	end	mark	in	any	word	processor	or	program	is	to	insert	a	symbol	at	the	end.	105.	Small	squares,	called	________,	on	the	selection	rectangle	that	surrounds	a	graphic	can	be	used	to	change	the	dimensions	of	the	graphic.	A.	Scroll
boxes	B.	Sizing	handles	C.	Status	indicators	D.	Move	handles	Answer	Answer:	Option	B	Explanation	:	Sizing	handles,	appear	at	the	four	corners	and	at	the	halfway	point	of	the	4	sides,	allow	us	to	change	the	dimensions	of	items,	such	as	a	graphic.	When	we	put	the	mouse	over	them	we	can	drag	to	change	the	size	of	the	item.	106.	Which	of	the
following	are	valid	Minimum	and	Maximum	zoom	sizes	in	Ms-office?	A.	10	100	B.	20	250	C.	10	500	D.	10	1000	Answer	Answer:	Option	C	Explanation	:	107.	You	can	replace	the	text	________	A.	Ctrl	+	H	B.	Ctrl	+	R	C.	Replace	from	edit	menu	D.	Both	A	and	C	Answer	Answer:	Option	D	Explanation	:	Shortcut	key	to	replace	is	Ctrl	+	H.	Replace	from	edit
menu	in	Word	2003	and	earlier	versions.	Home	>	Replace	in	Word	2007	and	higher	versions.	108.	To	update	a	formula	in	a	table,	press	the	A.	F9	keys	B.	ALT	+	F9	keys	C.	SHIFT	+	F9	keys	D.	F8	keys	Answer	Answer:	Option	A	Explanation	:	F9:	Update	a	field.	This	is	the	same	as	right-clicking	a	field	and	choosing	the	“Update	Field”	command.	Alt	+
F9:	Toggle	the	display	of	a	field’s	code.	Shift	+	F9:	Reveal	a	field’s	code.	F8:	Enter	Word’s	selection	mode	and	expand	a	selection.	109.	To	move	the	cursor	page	to	page	of	documents.	A.	Ctrl	+	Page	Down	B.	Ctrl	+	Page	Up	C.	Both	of	the	above	D.	None	of	the	above	Answer	Answer:	Option	C	Explanation	:	Ctrl	+	Page	Down	and	Ctrl	+	Page	Up	move
the	cursor	up	and	down	one	page	at	a	time.	110.	The	word	wrap	feature	________	A.	Automatically	moves	text	to	the	next	line	when	necessary	B.	Appears	at	the	bottom	of	the	document	C.	Allows	you	to	type	over	text	D.	Is	the	short	horizontal	line	indicating	the	end	of	the	document	Answer	Answer:	Option	A	Explanation	:	Word	wrap	is	a	word
processing	feature	that	forces	all	text	to	be	confined	within	defined	margins.	When	a	line	of	text	is	filled,	the	word	processor	automatically	moves	the	text	to	the	next	line,	so	the	we	do	not	have	to	press	the	return	key	after	every	line.	111.	You	can	move	the	insertion	point	in	a	table	A.	With	the	up	arrow	and	down	arrow	keys	B.	With	the	shift	+	tab	keys
C.	With	the	tab	key	D.	All	of	the	above	Answer	Answer:	Option	D	Explanation	:	Insertion	point	in	a	table	can	be	moved	With	the	up	arrow	and	down	arrow	keys	or	With	the	shift	+	tab	keys	or	With	the	tab	key.	112.	The	following	tool	bars	display	in	the	word	application	window	by	default	A.	Forms	tool	bar	B.	Formatting	tool	bar	C.	Drawing	tool	bar	D.
All	of	the	above	Answer	Answer:	Option	B	Explanation	:	The	Formatting	tool	bar	display	in	the	word	application	window	by	default	in	Word	2003.	113.	A	table	________	A.	Can	be	formatted	with	character	formats	like	bold	and	paragraph	formats	like	borders	and	shading	B.	Can	be	created	and	modified	with	a	button	on	the	standard	tool	bar	C.	Is	a
method	of	organizing	data	in	your	document	D.	Is	a	grid	organized	in	columns	and	rows	Answer	Answer:	Option	D	Explanation	:	A	table	is	a	grid	used	to	arrange	data	in	rows	and	columns.	A	table	is	structured	for	organizing	and	displaying	information	with	data	arranged	in	“rows	and	columns”.	114.	Which	key	or	key	combination	will	move	the
insertion	point	to	the	bottom	of	your	document?	A.	End	B.	Page	Down	C.	Ctrl	+	Page	Down	D.	None	of	the	above	Answer	Answer:	Option	D	Explanation	:	Ctrl+End	is	used	to	move	move	the	insertion	point	to	the	bottom	of	your	document.	115.	The	four	types	of	mail	merge	main	documents	are	________	A.	Form	letters	directories	catalogues	and
envelope	B.	Form	letters	envelops	and	mailing	labels	directories	and	lists	C.	Basic	letters	envelops	labels	and	list	D.	Form	letters	envelops	mailing	labels	and	catalogue	Answer	Answer:	Option	D	Explanation	:	The	four	types	of	mail	merge	main	documents	are	letters,	envelops,	mailing	labels	and	catalogue.	116.	Which	of	the	following	cannot	be	done
with	document	version?	A.	Modifying	a	version	B.	Deleting	a	version	C.	Opening	a	version	D.	None	of	the	above	Answer	Answer:	Option	D	Explanation	:	None	of	the	above	cannot	be	done	with	document	version.	The	Versions	feature	in	Word	was	removed	in	recent	versions	of	Word.	In	Word	2013,	the	only	way	you	can	access	previous	versions	of	a
document	in	Word	is	to	open	previous	automatically	saved	(autosaved)	versions	of	the	document.	You	can	also	open	recent	unsaved	documents.	However,	there	is	no	formal	versioning	feature	in	Word.	We	will	show	you	an	alternative	you	can	easily	add	to	Word	for	free	that	will	provide	this	capability.	117.	We	can	insert	maximum	number	of	columns
in	Ms	Word	are	________	A.	35	B.	15	C.	63	D.	65	Answer	Answer:	Option	C	Explanation	:	In	Microsoft	Word	you	can	insert	a	table	with	up	to	63	columns,	that	is	the	limit	to	the	number	of	columns	allowed	in	a	Word	document.	118.	Which	of	the	following	is	not	of	the	merge	process?	A.	Preview	the	merge	results	B.	Format	a	main	document	C.	Edit	a
data	source	D.	Identify	the	main	document	Answer	Answer:	Option	B	Explanation	:	Format	a	main	document	is	not	of	the	merge	process.	119.	Which	type	of	files	can	not	be	navigated	using	clip-art	browser?	A.	AVI	B.	BMP	C.	WAV	D.	MP3	Answer	Answer:	Option	D	Explanation	:	MP3	can	not	be	navigated	using	clip-art	browser.	120.	When	you	want	to
view	different	parts	of	a	document	without	moving	the	insertion	point.	A.	Use	the	previous	page	or	next	page	buttons	B.	Use	the	keyboard	C.	Use	the	vertical	and	horizontal	scroll	bars	D.	Use	the	zoom	button	Answer	Answer:	Option	C	Explanation	:	The	vertical	and	horizontal	scroll	bars	is	used	to	view	different	parts	of	a	document	without	moving	the
insertion	point.	121.	In	the	merge	process,	you	can	A.	Preview	a	merge	B.	Merge	directly	to	a	printer	C.	Merge	to	new	document	D.	All	of	the	above	Answer	Answer:	Option	D	Explanation	:	In	the	merge	process,	we	can	Merge	to	new	document,	Preview	a	merge,	Merge	directly	to	a	printer.	122.	To	view	smaller	text	on	the	screen	you	can	________	A.
Decrease	the	editing	percentage	B.	Increase	the	editing	percentage	C.	Decrease	the	view	percentage	D.	Increase	the	view	percentage	Answer	Answer:	Option	C	Explanation	:	Decrease	the	view	percentage	to	view	smaller	text	on	the	screen.	123.	Thesaurus	tool	in	MS	Word	is	used	for	________	A.	Spelling	suggestions	B.	Synonyms	and	Antonyms	words
C.	Translate	D.	None	of	these	Answer	Answer:	Option	B	Explanation	:	Using	the	thesaurus,	we	can	find	synonyms	(different	words	with	the	same	meaning)	and	antonyms	(words	with	the	opposite	meaning).	In	Microsoft	Office	Word	you	can	look	up	a	word	quickly	if	we	right-click	anywhere	in	our	document,	and	then	click	Synonym	on	the	shortcut
menu.	124.	A	character	that	is	raised	and	smaller	above	the	baseline	is	known	as	A.	Raised	B.	Outlined	C.	Capscript	D.	Superscript	Answer	Answer:	Option	D	Explanation	:	A	superscript	is	a	number,	figure,	symbol,	or	indicator	that	is	smaller	than	the	normal	line	of	type	and	is	set	slightly	above	it.	125.	The	minimum	number	of	rows	and	columns	in	MS
Word	document	is	A.	1	and	1	B.	2	and	1	C.	1	and	2	D.	2	and	2	Answer	Answer:	Option	A	Explanation	:	The	minimum	number	of	rows	and	columns	in	MS	Word	document	is	1	row	and	1	column.	126.	What	is	the	smallest	and	largest	font	size	available	in	Font	Size	tool	on	formatting	toolbar?	A.	8	and	72	B.	8	and	68	C.	6	and	72	D.	6	and	68	Answer
Answer:	Option	A	Explanation	:	127.	Selecting	text	means,	selecting	________	A.	A	word	B.	An	entire	sentence	C.	Whole	document	D.	Any	of	the	above	Answer	Answer:	Option	D	Explanation	:	Selecting	text	means,	selecting	a	word	or	an	entire	sentence	or	a	whole	document.	128.	MS-Word	automatically	moves	the	text	to	the	next	line	when	it	reaches
the	right	edge	of	the	screen	and	is	called?	A.	Carriage	Return	B.	Enter	C.	Word	Wrap	D.	None	of	the	above	Answer	Answer:	Option	C	Explanation	:	Word	wrap	is	a	word	processing	feature	that	forces	all	text	to	be	confined	within	defined	margins.	When	a	line	of	text	is	filled,	the	word	processor	automatically	moves	the	text	to	the	next	line,	so	the	we	do
not	have	to	press	the	return	key	after	every	line.	129.	In	MS-Word,	for	what	does	ruler	help?	A.	To	set	tabs	B.	To	set	indents	C.	To	change	page	margins	D.	All	of	the	above	Answer	Answer:	Option	D	Explanation	:	In	Microsoft	Word	Ruler	helps	to	set	tabs,	to	change	a	line’s	indentation,	click	and	hold	the	bottom	bar,	then,	drag	it	left	to	decrease	the
indentation,	or	right	to	increase	it.	If	we	want	to	adjust	the	hanging	or	first	line	indent,	drag	the	up	and	down	arrows	left	or	right.	It	also	help	to	to	change	page	margins.	130.	Which	menu	in	MS	Word	can	be	used	to	change	character	size	and	typeface?	A.	View	B.	Tools	C.	Format	D.	Data	Answer	Answer:	Option	C	Explanation	:	Format	menu	in	MS
Word	can	be	used	to	change	character	size	and	typeface?	131.	Which	option	in	File	pull-down	menu	is	used	to	close	a	file	in	MS	Word?	A.	New	B.	Quit	C.	Close	D.	Exit	Answer	Answer:	Option	C	Explanation	:	Close	option	in	File	pull-down	menu	is	used	to	close	a	file	in	MS	Word.	132.	What	is	the	function	of	CTRL	+	R	in	MS-Word	A.	Open	the	Print
dialog	box	B.	Update	the	current	Web	page	C.	Close	the	current	window	D.	None	of	these	Answer	Answer:	Option	D	Explanation	:	In	Microsoft	Word,	pressing	Ctrl	+	R	aligns	the	line	or	selected	text	to	the	right	of	the	screen.	133.	What	is	the	extension	of	files	created	in	Ms-Word	97-	2003	A.	.docm	B.	.doc	C.	.docx	D.	.txt	Answer	Answer:	Option	B
Explanation	:	.doc	–	Word	97-2003	Document	–	The	binary	file	format.	.docx	–	Word	Document	2007	and	higher	versions	–	The	default	XML-based	file	format.	.docm	–	Word	Macro-Enabled	Document	2007	and	higher	versions	–	The	XML-based	and	macro-enabled	file	format.	.txt	–	Plain	Text	–	A	document	as	a	.txt	file,	the	document	loses	all	formatting.
134.	Why	headers	and	footers	used	in	MS	-Word	A.	To	enhance	the	overall	appearance	of	the	document	B.	To	mark	the	starting	of	a	page	C.	To	make	large	document	more	readable	D.	To	allow	page	headers	and	footers	to	appear	on	document	when	it	is	printed	Answer	Answer:	Option	D	Explanation	:	A	header	is	the	top	margin	of	each	page,	and	a
footer	is	the	bottom	margin	of	each	page.	Headers	and	footers	are	useful	for	including	material	that	we	want	to	appear	on	every	page	of	a	document	such	as	your	name,	the	title	of	the	document,	or	page	numbers.	135.	In	MS-Word	shortcut	Shift	+	Delete	is	used	to	A.	Delete	the	selected	item	permanently	without	placing	the	item	in	the	Recycle	Bin	B.
Copy	the	selected	item	C.	Rename	the	selected	item	D.	Create	a	shortcut	to	the	selected	item	Answer	Answer:	Option	A	Explanation	:	Shift	+	Delete	is	used	to	delete	the	selected	item	permanently	without	placing	the	item	in	the	Recycle	Bin.	136.	What	is	the	default	number	of	lines	to	drop	for	drop	cap?	A.	3	B.	10	C.	15	D.	20	Answer	Answer:	Option	A
Explanation	:	A	drop	cap	is	a	large	capital	letter	at	begin	of	a	paragraph	that,	typically,	has	the	depth	of	two	or	more	lines	of	normal	text.	It	is	set	to	‘3’	by	default,	although	any	choice	from	2	onwards.	137.	A	bookmark	is	an	item	or	location	in	document	that	you	identify	a	name	for	future	Reference.	Which	of	the	following	task	is	accomplished	by	using
bookmarks?	A.	To	mark	the	ending	of	a	page	of	document	B.	To	quickly	jump	to	a	specific	location	in	the	document	C.	To	add	hyperlinks	in	a	web	page	D.	None	of	These	Answer	Answer:	Option	B	Explanation	:	Bookmark	in	MS	Word	is	a	specific	word,	section,	or	location	in	our	Word	document	that	we	want	to	name	and	identify	for	future	reference.
For	example,	let’s	say	we	need	to	identify	a	text,	a	number	we	want	to	revise	at	a	later	time.	With	the	use	of	bookmarks,	there	is	no	need	of	scrolling	through	the	document	in	order	to	find	the	text.	Just	use	the	bookmark,	and	we	can	quickly	and	easily	jump	to	the	text.	138.	What	is	the	maximum	number	of	lines	you	can	set	for	a	drop	cap?	A.	10	B.	15
C.	20	D.	Undefine	Answer	Answer:	Option	A	Explanation	:	For	a	drop	cap	maximum	number	of	lines	10	and	minimum	number	of	line	1	can	be	set.	By	default	it	is	3.	139.	How	can	you	insert	a	sound	file	in	your	word	document?	A.	From	insert	>	sound	menu	option	B.	From	insert	>	file	menu	option	C.	From	insert	>	object	menu	option	D.	None	of	these
Answer	Answer:	Option	C	Explanation	:	In	word	2003	and	earlier	versions	from	insert	>	object	menu	option	a	sound	file	can	be	inserted	in	our	word	document.	In	word	2007	and	higher	version	from	Insert	>	Text	>	Object	option	a	sound	file	can	be	inserted	in	our	word	document.	140.	Macros	are:	A.	Small	programs	created	in	MS-Word	to	automate
repetitive	tasks	by	using	VBA	B.	Small	add-on	programs	that	are	installed	afterwards	if	you	need	them	C.	Programming	language	that	you	can	use	to	customize	MS-Word	D.	Large	tools	in	Word	such	as	mail	merge	Answer	Answer:	Option	A	Explanation	:	A	macro	can	help	improve	efficiency	when	creating	documents	and	spreadsheets,	adding	or
maintaining	information,	or	creating	forms	for	other	people	to	fill	out.	Microsoft	Word	and	Excel	are	popular	software	in	which	people	utilize	macros	to	make	data	entry	and	retention	easier.	Macros	in	Word	and	Excel	are	created	using	the	Visual	Basic	programming	language	or	by	recording	actions	performed.	141.	A	template	stores:	A.	Graphics	text
styles	macros	B.	Customized	word	command	setting	C.	Auto	text	entries	D.	All	of	above	Answer	Answer:	Option	D	Explanation	:	A	template	stores	Graphics,	text,	styles,	macros,	customized	word	command	setting,	auto	text	entries.	142.	What	do	you	mean	by	vertical	separation	between	columns?	A.	Orientation	B.	Gutter	C.	Margin	D.	Index	Answer
Answer:	Option	C	Explanation	:	Margin	143.	What	does	EXT	indicator	on	status	bar	of	MS	Word	indicate?	A.	It	indicates	whether	the	external	text	is	pasted	on	document	or	not	B.	It	indicates	whether	extended	add-ons	are	installed	on	MS	Word	or	not	C.	It	indicates	whether	Extended	Selection	mode	is	turned	on	or	off	D.	None	of	These	Answer
Answer:	Option	C	Explanation	:	EXT	indicator	indicates	whether	or	not	Extend	Selection	Mode	is	turned	off	or	on.	Pressing	F8	turns	it	on	and	it	anchors	the	cursor.	If	we	press	any	arrow	keys	at	that	point	the	text	will	be	selected	from	the	anchor	point.	The	Status	Bar	indicates	that	we	are	in	Extend	Selection	mode.	(In	versions	of	Word	earlier	than
2007,	the	status	bar	indicates	EXT.)	Pressing	the	Escape	key	will	take	us	out	of	Extend	Selection	mode.	144.	Why	Drop	Caps	are	used	in	document?	A.	To	drop	all	the	capital	letters	B.	To	automatically	begin	each	paragraph	with	capital	letter	C.	To	begin	a	paragraph	with	a	large	dropped	initial	capital	letter	D.	None	of	These	Answer	Answer:	Option	C
Explanation	:	A	drop	cap	is	a	large	capital	letter	at	begin	of	a	paragraph	that,	typically,	has	the	depth	of	two	or	more	lines	of	normal	text.	It	is	set	to	‘3’	by	default,	although	any	choice	from	2	onwards.	145.	Which	of	the	following	is	not	a	type	of	page	margin?	A.	Right	B.	Center	C.	Left	D.	Top	Answer	Answer:	Option	B	Explanation	:	Center	is	not	a	type
of	page	margin	146.	What	is	the	default	left	margin	in	Word	2003	document?	A.	1	B.	1.25	C.	1.5	D.	2	Answer	Answer:	Option	B	Explanation	:	In	Word	2003	and	earlier,	the	default	top	and	bottom	margins	were	1	inch	(25.4	mm),	but	1.25	inches	(31.7	mm)	were	given	at	the	left	and	the	right.	The	default	margins	for	Microsoft	Word	from	version	2007
onward	have	been	1	inch	(25.4	mm)	all	around.	147.	If	you	need	to	change	the	typeface	of	a	document,	which	menu	will	you	choose?	A.	Edit	B.	View	C.	Format	D.	Tools	Answer	Answer:	Option	C	Explanation	:	Format	menu	is	used	to	change	typeface	of	a	document.	148.	Which	of	the	following	is	not	a	font	style?	A.	Bold	B.	Italics	C.	Regular	D.
Superscript	Answer	Answer:	Option	D	Explanation	:	A	superscript	is	a	character,	symbol	or	number	set	slightly	above	the	normal	line	of	text.	It	is	always	smaller	than	the	usual	font	and	is	typically	found	in	mathematical	or	scientific	formulas.	it	is	effects	to	the	font.	149.	What	is	the	maximum	font	size	you	can	apply	for	any	character?	A.	163	B.	1638	C.
16038	D.	72	E.	None	of	above	Answer	Answer:	Option	B	Explanation	:	The	maximum	font-size	available	in	Microsoft	Word	2010	from	the	dropdown	list	is	72;	however	the	font	size	can	be	set	up	to	1638	by	typing	the	size	manually	for	the	font	150.	To	autofit	the	width	of	column	A.	Double	click	the	left	border	of	column	B.	Double	click	the	right	border
of	column	C.	Double	click	the	column	header	D.	All	of	above	Answer	Answer:	Option	B	Explanation	:	To	make	the	columns	in	a	table	automatically	fit	the	contents,	click	on	our	table.	On	the	Layout	tab,	in	the	Cell	Size	group,	click	AutoFit,	and	then	click	AutoFit	Contents.	or	double	click	the	right	border	of	column.	151.	When	inserting	Page	number	in
footer	it	appeared	1	but	you	wish	to	show	a.	How	can	you	do	that?	A.	From	Insert	menu	choose	Page	Number	and	specify	necessary	setting	B.	From	format	menu	choose	bullets	and	Numbering	and	configure	necessary	setting	C.	Click	on	Page	Number	Format	tool	and	specify	required	setting	D.	All	of	above	Answer	Answer:	Option	C	Explanation	:
Click	on	Page	Number	Format	tool	and	specify	required	setting	in	Word	2003	and	earlier	version.	Insert	tab,	click	the	Page	Number	command	and	specify	required	setting	in	Word	2007	and	higher	version.	152.	To	get	to	the	‘Symbol’	dialog	box,	click	on	the	______	menu	and	choose	‘Symbol’.	A.	Tools	B.	Table	C.	Insert	D.	Format	Answer	Answer:
Option	C	Explanation	:	To	get	to	the	‘Symbol’	dialog	box,	click	on	the	Insert	menu	and	choose	‘Symbol’	in	Word	2003.	153.	AutoCorrect	was	originally	designed	to	replace	_________	words	as	you	type.	A.	Grammatically	incorrect	B.	Short	repetitive	C.	Misspelled	D.	None	of	the	above	Answer	Answer:	Option	C	Explanation	:	Misspelled	words	will
automatically	be	corrected	while	typing	with	Autocorrect	feature.	154.	In	Word,	the	mailing	list	is	known	as	the	________.	A.	Data	source	B.	Sheet	C.	Data	sheet	D.	Source	Answer	Answer:	Option	A	Explanation	:	A	mailing	list	as	a	data	source	for	names	and	addresses	in	a	mail	merge.	155.	What	is	the	default	font	size	of	a	new	Word	document	based	on
Normal	template?	A.	9	pt	B.	11	pt	C.	14	pt	D.	None	of	above	Answer	Answer:	Option	B	Explanation	:	In	Word	2003	and	earlier	versions,	default	font	size	was	Times	New	Roman,	12	pt.	From	Microsoft	Word	2007	and	higher	versions	default	font	size	is	Calibri,	11	pt.	156.	What	is	the	default	font	used	in	MS	Word	2016	document?	A.	Times	New	Roman
B.	Arial	C.	Algerian	D.	None	of	the	above	Answer	Answer:	Option	D	Explanation	:	In	Word	2003	and	earlier	versions,	default	font	was	Times	New	Roman,	12	pt.	From	Microsoft	Word	2007	and	higher	versions	default	font	is	Calibri,	11	pt.	157.	Drop	Cap	means	A.	Small	Caps	B.	Title	case	C.	All	Caps	D.	None	of	above	Answer	Answer:	Option	D
Explanation	:	A	drop	cap	is	a	large	capital	letter	at	begin	of	a	paragraph	that,	typically,	has	the	depth	of	two	or	more	lines	of	normal	text.	It	is	set	to	‘3’	by	default,	although	any	choice	from	2	onwards.	158.	Which	indent	marker	controls	all	the	lines	except	first	line?	A.	Left	Indent	Marker	B.	First	Line	Indent	Marker	C.	Right	Indent	Marker	D.	Hanging
Indent	Marker	Answer	Answer:	Option	D	Explanation	:	A	Hanging	indent,	also	known	as	a	second	line	indent,	sets	off	the	first	line	of	a	paragraph	by	positioning	it	at	the	margin,	and	then	indenting	each	subsequent	line	of	the	paragraph.	159.	Which	of	the	following	option	is	not	available	in	Insert	>	Picture?	A.	Chart	B.	Graph	C.	Clip	Art	D.	Word	Art
Answer	Answer:	Option	B	Explanation	:	Graph	is	not	available	in	MS	word	Insert	option.	160.	How	many	different	positions	can	you	set	for	drop	cap?	A.	1	B.	2	C.	3	D.	4	Answer	Answer:	Option	B	Explanation	:	Two	different	positions	can	you	set	for	drop	cap	–	Dropped	and	In	margin.	161.	Which	of	the	following	is	used	to	create	newspaper	style
columns?	A.	Format	Columns	B.	Table	Insert	Table	C.	Format	Tabs	D.	Insert	Textbox	Answer	Answer:	Option	A	Explanation	:	Newspaper	articles,	Newsletters,	and	Flyers—are	often	written	in	column	format.	Word	also	allows	us	to	adjust	your	columns	by	adding	column	breaks.	162.	Columns	dialog	box	can	be	opened	from	________	A.	Press	Alt	+	O	+	C
B.	Format	menu	Columns	submenu	C.	Double	click	on	column	space	in	ruler	D.	All	of	the	above	Answer	Answer:	Option	D	Explanation	:	Columns	dialog	box	can	be	opened	from	all	of	the	above	options.	163.	You	can	jump	to	the	next	column	by	A.	Press	Alt	+	Down-arrow	B.	Clicking	with	your	mouse	on	the	next	column	C.	Both	of	above	D.	None	of
Above	Answer	Answer:	Option	C	Explanation	:	We	can	jump	to	the	next	column	by	pressing	Alt	+	Down-arrow	or	clicking	with	your	mouse	on	the	next	column.	164.	To	open	Columns	dialog	box	quickly	________	A.	Double	click	the	space	between	area	on	ruler	B.	Double	click	the	right	margin	in	ruler	C.	Double	click	on	the	left	margin	area	of	ruler	D.	All
of	above	Answer	Answer:	Option	A	Explanation	:	Double	click	the	space	between	area	on	ruler	or	Press	Alt	+	O	+	C	to	open	Columns	dialog	box	quickly.	165.	Text	boundary	can	be	displayed	or	hidden	from	A.	Customize	from	Tools	menu	B.	Auto	text	option	from	Insert	menu	C.	Options	from	Tools	menu	D.	All	of	above	Answer	Answer:	Option	C
Explanation	:	“Text	boundaries”	checked	in	Word’s	Options,	however,	the	cell	boundaries	will	still	be	outlined	with	a	dotted	line	in	Print	Layout	and	Web	Layout	views.	Find	this	setting	on	the	View	tab	of	Tools	>	Options	in	Word	2003	and	earlier	versions.	In	Word	2007	and	higher	versions,	it	is	under	Show	document	content	on	the	Advanced	tab	of
Office/File	>	Options	>	Advanced.	166.	You	wished	to	justify	text	over	the	height	of	paper,	which	option	will	you	choose	________	A.	From	formatting	toolbar	B.	Page	Setup	from	File	menu	C.	Font	from	Format	menu	D.	Paragraph	from	Format	menu	Answer	Answer:	Option	B	Explanation	:	Page	Setup	from	File	menu	is	used	to	justify	text	over	the	height
of	paper.	167.	Which	of	the	following	is	not	the	part	of	standard	office	suite?	A.	Database	B.	File	manager	C.	Image	Editor	D.	Word	Processor	Answer	Answer:	Option	B	Explanation	:	Database	–	Microsoft	Office	Access	Image	Editor	–	Microsoft	Office	Picture	Manager	Word	Processor	–	Microsoft	Office	Word	168.	Where	can	you	find	the	Draw	Table
tool	button?	A.	Formatting	toolbar	B.	Drawing	toolbar	C.	Standard	toolbar	D.	Tables	and	Formatting	toolbar	Answer	Answer:	Option	D	Explanation	:	Draw	Table	tool	button	is	found	in	Tables	and	Formatting	toolbar	in	Word	2003	and	earlier	versions.	Draw	Table	tool	button	is	found	in	Insert	>	Table	>	Draw	Table	in	Word	2007	and	higher	versions	.
169.	Superscript,	subscript,	outline,	emboss,	engrave	are	known	as	A.	Font	effects	B.	Text	effects	C.	Font	styles	D.	Word	art	Answer	Answer:	Option	A	Explanation	:	Superscript,	subscript,	outline,	emboss,	engrave	are	known	as	Font	effects.	170.	Shimmer,	Sparkle	text,	Blinking	Background	etc	are	known	as	A.	Word	art	B.	Font	styles	C.	Text	effects	D.
Font	effects	Answer	Answer:	Option	C	Explanation	:	Text	effects	–	these	effects	are	found	on	the	text	effects	tab.	These	are	simply	animations	that	can	be	applied	to	text,	for	example,	the	blinking	background,	Las	Vegas	lights,	shimmer,	and	others.	171.	The	feature	of	Word	that	automatically	adjusts	the	amount	of	space	between	certain	combination
of	characters	so	that	an	entire	word	looks	more	evenly	spaced.	What	is	that	feature	called?	A.	Spacing	B.	Kerning	C.	Positioning	D.	Scaling	Answer	Answer:	Option	B	Explanation	:	Kerning	adjusts	the	horizontal	space	between	letters	so	they	look	right	to	the	human	eye.	It’s	necessary	because	letters	take	up	different	amounts	of	space	and	the	letter
shape	can	clash	with	the	ones	either	side.	172.	A	feature	of	MS	Word	that	saves	the	document	automatically	after	certain	interval	is	available	on	A.	Save	tab	on	Options	dialog	box	B.	Save	As	dialog	box	C.	Both	of	above	D.	None	of	above	Answer	Answer:	Option	A	Explanation	:	A	feature	of	MS	Word	that	saves	the	document	automatically	after	certain
interval	is	available	on	Save	tab	on	Options	dialog	box	is	called	Auto	Recover.	173.	What	happens	if	you	press	Ctrl	+	Shift	+	F8?	A.	It	activates	extended	selection	B.	It	activates	the	rectangular	selection	C.	It	selects	the	paragraph	on	which	the	insertion	line	is	D.	None	of	above	Answer	Answer:	Option	B	Explanation	:	It	activates	the	rectangular
selection	174.	What	is	the	shortcut	key	you	can	press	to	create	a	copyright	symbol?	A.	Alt	+	Ctrl	+	C	B.	Alt	+	C	C.	Ctrl	+	C	D.	Ctrl	+	Shift	+	C	Answer	Answer:	Option	A	Explanation	:	Alt	+	Ctrl	+	C	is	used	to	create	©	copyright	symbol	in	Word.	175.	When	assigning	a	shortcut	key	to	a	symbol,	you	should	always	try	to	select	a	key	or	key	combination
that	is:	A.	Unassigned	B.	Located	on	the	ten-key	pad	section	of	your	keyboard.	C.	Assigned	to	another	task.	D.	From	the	same	font	family	as	the	symbol.	Answer	Answer:	Option	A	Explanation	:	When	assigning	a	shortcut	key	to	a	symbol,	we	should	always	try	to	select	a	key	or	key	combination	that	is	unassigned	else	we	could	unintentionally	remove
important	combinations	from	Word.	176.	Suppose	you	wanted	to	create	an	AutoCorrect	entry	that	would	type	the	words	‘We	regret	to	inform	you	that	your	submission	has	been	declined’	Of	the	following	choices,	which	would	be	the	best	name	you	could	assign	to	this	entry?	A.	Regret	B.	Subdual	C.	We	regret	to	inform	you	that	your	submission	has
been	declined	D.	11	Answer	Answer:	Option	B	Explanation	:	Subdual	is	not	commonly	word	whereas	other	options	are	used	frequently	used	word.	So	in	given	option	less	common	word	is	subdual	and	when	we	assign	it	to	auto	correct	option	when	ever	we	type	subdual	word	will	auto	bring	entire	sentence	‘We	regret	to	inform	you	that	your	submission
has	been	declined’.	177.	If	you	want	to	convert	a	symbol	or	several	lines	of	text	into	an	AutoCorrect	entry,	you	should:	A.	Insert	the	symbol	or	type	the	text	in	a	Word	document	first.	Then	select	the	text	or	symbol	and	go	to	the	AutoCorrect	dialog	box.	B.	Click	the	Tools	menu	and	choose	AutoCorrect	Options.	Then	click	the	Insert	menu	and	choose
Symbol	(or	click	the	Format	menu	and	choose	Paragraph)	to	add	the	symbol	or	paragraph	to	AutoCorrect.	C.	AutoCorrect	can	only	accommodate	one	line	of	text.	It	is	not	possible	to	convert	a	symbol	or	multiple	lines	of	text	into	an	AutoCorrect	entry.	D.	Insert	the	symbol	or	type	the	text	in	a	Word	document	first.	Then	select	the	text	or	symbol	and
click	the	Edit	menu	followed	by	Paste	Special.	Select	New	AutoCorrect	Entry	and	then	click	OK.	Answer	Answer:	Option	A	Explanation	:	Insert	the	symbol	or	type	the	text	in	a	Word	document	first.	Then,	select	the	text	or	symbol	and	go	to	the	AutoCorrect	dialog	box.	178.	How	can	you	access	the	font	size	tool	on	formatting	toolbar?	A.	Ctrl	+	S	B.	Ctrl
+	Shift	+	S	C.	Ctrl	+	P	D.	Ctrl	+	Shift	+	P	Answer	Answer:	Option	D	Explanation	:	Ctrl	+	Shift	+	P	is	used	to	change	the	font	size.	179.	How	can	you	make	the	selected	character	superscripted?	A.	Ctrl	+	=	B.	Ctrl	+	Shift	+	+	C.	Alt	+	Ctrl	+	Shift	+	=	D.	None	of	above	Answer	Answer:	Option	B	Explanation	:	For	superscript,	press	Ctrl,	Shift,	and	the
Plus	sign	(+)	at	the	same	time.	180.	What	does	Ctrl	+	=	key	effect?	A.	Superscript	B.	Subscript	C.	All	Caps	D.	Shadow	Answer	Answer:	Option	B	Explanation	:	For	subscript,	press	Ctrl	and	the	Equal	sign	(=)	at	the	same	time.	181.	How	can	you	increase	the	font	size	of	selected	text	by	one	point	every	time?	A.	By	pressing	Ctrl	+	]	B.	By	pressing	Ctrl	+	[
C.	By	pressing	Ctrl	+	}	D.	By	pressing	Ctrl	+	{	Answer	Answer:	Option	A	Explanation	:	To	increase	the	font	size,	press	Ctrl+].	To	decrease	the	font	size,	press	Ctrl+[.	182.	What	is	the	smallest	width	of	a	column?	A.	0″	B.	0.5″	C.	1″	D.	1.5″	Answer	Answer:	Option	B	Explanation	:	0.5″	183.	How	much	space	in	minimum	must	be	provided	between
columns?	A.	0″	B.	0.5″	C.	1″	D.	1.5″	Answer	Answer:	Option	A	Explanation	:	0″	184.	Which	of	the	following	is	not	available	in	Font	Spacing?	A.	Normal	B.	Loosely	C.	Condensed	D.	Expanded	Answer	Answer:	Option	B	Explanation	:	Click	the	Home	tab	>	Click	the	Font	Dialog	Box	Launcher	>	Click	the	Advanced	tab	>	Click	the	Spacing	list	arrow,	click	an
option,	and	then	specify	a	point	size	to	expand	or	condense	spacing	by	the	amount	specified.	185.	Which	of	the	following	position	is	not	available	for	fonts	on	MS	Word?	A.	Normal	B.	Raised	C.	Lowered	D.	Centered	Answer	Answer:	Option	D	Explanation	:	186.	What	is	the	maximum	scale	percentage	available	in	Scale	drop	down	box?	A.	500	B.	200	C.
100	D.	90	Answer	Answer:	Option	B	Explanation	:	200	187.	Uppercase	on	Change	Case	dialog	box	and	All	Caps	on	Fonts	dialog	box	both	converts	selected	text	into	Capital	Letters.	What’s	the	difference	between	the	two?	A.	Both	are	same.	They	are	only	two	different	ways	of	capitalize	text	B.	It	is	faster	to	convert	from	Change	Case	than	from	Font
dialog	box	C.	Change	Case	makes	conversion	permanent	but	All	Caps	on	Font	can	always	be	reverted	D.	All	Caps	on	Font	dialog	box	makes	the	change	permanent	where	Change	Case	can	be	always	reverted	Answer	Answer:	Option	C	Explanation	:	Change	Case	makes	conversion	permanent	but	All	Caps	on	Font	can	always	be	reverted	188.	Changing
the	appearance	of	a	document	is	called	A.	Proofing	B.	Editing	C.	Formatting	D.	All	of	above	Answer	Answer:	Option	C	Explanation	:	Changing	the	appearance	of	a	document	is	called	Formatting.	Depending	on	the	purpose	of	our	document,	altering	certain	formatting	elements	like	backgrounds,	lines,	margins,	or	highlighting	may	be	crucial.	189.	Which
language	does	MS-Word	use	to	create	Macros?	A.	Visual	C++	B.	Visual	Basic	C.	FoxPro	D.	Access	Answer	Answer:	Option	B	Explanation	:	A	macro	can	help	improve	efficiency	when	creating	documents	and	spreadsheets,	adding	or	maintaining	information,	or	creating	forms	for	other	people	to	fill	out.	Microsoft	Word	and	Excel	are	popular	software	in
which	people	utilize	macros	to	make	data	entry	and	retention	easier.	Macros	in	Word	and	Excel	are	created	using	the	Visual	Basic	programming	language	or	by	recording	actions	performed.	190.	Which	key	is	used	to	increase	left	indent?	A.	Ctrl	+	I	B.	Ctrl	+	M	C.	Alt	+	I	D.	F10	Answer	Answer:	Option	B	Explanation	:	CTRL	+	M	is	used	to	Indent	a
paragraph	from	the	left.	191.	Which	key	is	used	to	select	all	the	text	in	the	document?	A.	Ctrl	+	T	B.	Ctrl	+	A	C.	Ctrl	+	F	D.	Ctrl	+	N	Answer	Answer:	Option	B	Explanation	:	Ctrl	+	A	is	used	to	select	all	text	in	the	document.	192.	To	undo	the	last	work,	press	________	A.	Ctrl	+	U	B.	Ctrl	+	Y	C.	Ctrl	+	Z	D.	Ctrl	+	W	Answer	Answer:	Option	C	Explanation	:
Ctrl-Z	(Undo)	is	used	to	restore	the	last	editing	operation	that	has	taken	place.	193.	To	Redo	the	last	work,	press	________	A.	Ctrl	+	U	B.	Ctrl	+	Y	C.	Ctrl	+	Z	D.	Ctrl	+	W	Answer	Answer:	Option	B	Explanation	:	Ctrl+Y	is	a	shortcut	key	most	often	used	to	redo	an	undo.
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